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  การใช้งานโปรแกรม 
Microsoft Excel 

 
 

วัตถุประสงค์ 
 อธิบายถึงประเภทของการท างานของ Microsoft Excel  
 อธิบายส่วนประกอบของ Microsoft Excel 
 อธิบายกฎเกณฑ์เกี่ยวกับการค านวณ 
 ตัวอย่างการคิดค านวณการตัดเกรด 
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การใช้งานโปรแกรม Microsoft Excel 
 

โปรแกรม Microsoft Excel หรือเรียกว่า Excel เป็นโปรแกรมประเภท สเปรดชีต (Spread Sheet) 
เหมาะส าหรับการจัดการเกี่ยวกับการค านวณ หาผลลัพธ์ การสร้างกราฟ แผนภูมิ ซึ่ง Excel ยังสามารถป้อน
ข้อความ แทรกรูปภาพ และสัญลักษณ์พิเศษต่างๆของตัวเลข และการจัดการเกี่ยวกับตารางข้อมูลได้ Excel มี
ฟังก์ชันในการค านวณให้ผู้ใช้สามารถเลือกใช้มากมาย จึงท าให้สามารถน ามาใช้ในการวิเคราะห์ค านวณค่าตัวเลข
ต่างๆได้สะดวก ดังนั้นจึงไม่ต้องสงสัยที่หนึ่งในโปรแกรมประยุกต์ในท้องตลาดจะต้องมีการน า Excel ไปใช้กับ
งานหลายๆ สาขาอาชีพ เช่น นักบัญชี นักวิทยาศาสตร์ วิศวกร นักสถิติ นักวางแผน และครู อาจารย์ เป็นต้น  
โดยลักษณะทั่วไปแล้ว Excel เป็นโปรแกรมที่อยู่ในชุดของ Microsoft Office เช่นเดียวกับ โปรแกรม Microsoft 
PowerPoint และ Microsoft Word ที่นักศึกษาได้เรียนรู้ไปแล้ว ส่วนใหญ่จะมีรูปแบบหน้าจอเมนูค าสั่ง เมนู
บาร์ที่มีการสั่งการเหมือนกัน เช่น การปรับเปลี่ยนขนาดตัวอักษร การปรับเปลี่ยนสีตัวอักษร การท าตัวอักษรให้
เป็นตัวหนา ตัวเอียง การสร้างตารางข้อมูล เป็นต้น  ทั้งนี้จะมีข้อแตกต่างกันในรายละเอียดเฉพาะที่เป็นจุดเด่น
ของโปรแกรมนั้นๆ ซึ่งในเอกสารนี้จะได้มาเรียนรู้กันในส่วนการใช้งานโปรแกรม Microsoft Excel 

 
1. การเข้าสู่การใช้งานโปรแกรม Microsoft Excel 

1. น าเมาส์คลิกเมนู start ->programs-> Microsoft Excel     ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 1 การเรียกใช้งานโปรแกรม Microsoft Excel 
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2. ส่วนประกอบต่างๆ ของ Excel เมื่อเปิดโปรแกรมขึ้นมา 
เมื่อเปิดโปรแกรม Excel แล้วหน้าจอท่ีได้จะมีส่วนตา่งๆ ที่ควรรู้จักซึง่จะท าให้ผู้ใช้สามารถที่จะใช้งาน 

Excel ได้ตามความต้องการ ส่วนประกอบต่างๆ มีดังนี ้
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 2 ชื่อส่วนประกอบโปรแกรม Microsoft Excel 

แต่ละส่วนประกอบ มีรายละเอียดดังนี้ 
แถบชื่อเร่ือง (Title Bar) เป็นส่วนแสดงว่าเราใช้โปรแกรม Excel เปิดแฟ้มชื่ออะไรอยู่ 
ปุ่มควบคุมโปรแกรม (Control Button) ใช้ควบคุมขนาดหน้าต่างโปรแกรม เช่น ย่อ ขยาย และปิด 
แถบเมนู (Menu bar) เป็นการน าเอาค าสั่งที่ใช้บ่อยๆ มาสร้างเป็นปุ่ม เพื่อให้สะดวกต่อการเรียกใช้งาน 
แถบเคร่ืองมือ (Toolbar) เป็นการน าเอาค าสั่งท่ีใช้บ่อยๆ มาสร้างเป็นปุ่ม เพื่อให้สะดวกต่อการเรียกใช้งาน 
แถบสูตร (Formula bar) เป็นแถบที่ใช้ส าหรับให้ก าหนดสูตรค านวณข้อมูล 
ชีต หรือ เวิร์กชีต (Sheet or Work Sheet) เป็นพื้นที่ท่ีจะท างาน ซึ่งจะมองเห็นเป็นลักษณะตาราง โดยแต่ละ
ช่องตารางจะเรียกว่า “เซลล์ (Cell)” 
แถบสถานะ (Status Bar) ใช้แสดงสภาวะต่างๆ ของโปรแกรม เช่น การกดปุ่มพิเศษ และการพิมพ์งานออก
ทางพรินเตอร์ เป็นต้น 

 

แถบเคร่ืองมือ แถบเมนู แถบสูตร 
ปุ่มควบคุม
โปรแกรม 

แถบงาน แถบเล่ือน (Scroll Bar) 

แถบช่ือเร่ือง 

ช่ือเซลล ์

แถบสถานะ ชีต หรือ Work Sheet 

ช่ือแถว 

ช่ือคอลมัน ์
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แถบเลื่อน (Scroll Bar) ใช้เลื่อนไปยังพื้นที่ของเซลล์ที่ต้องการที่ไม่สามารถแสดงให้เห็นทั้งหมดในหน้าจอได้ 
ชื่อเซลล์ (Name Box) เป็นช่องที่แสดงถึงการระบุต าแหน่งของเซลล์โดยจะแสดงต าแหน่งของเซลล์ 
เช่น ช่ือเซลล์ปรากฏช่ือ E3  ซึ่งช่ือเซลล์จะได้มาจากการน าช่ือหัวคอลัมน์ (Column Name) มาต่อด้วย ช่ือแถว 
(Row Name) โดยจะต้องมีการอ่านบังคับตามล าดับ เหมือนกับการอ่านจุดพิกัดบนแผนที่ ดังนั้น E3 หมายถึง 
เซลล์  E3  ที่เกิดจากคอลัมน์ E  ตัดกับแถวท่ี 3 
ชื่อแถว (Row Name) เป็นสิ่งที่ใช้ในการก าหนดการอ้างอิงต าแหน่งข้อมูลในแนวนอน 
ชื่อคอลัมน์ (Column Name) เป็นสิ่งทีใ่ช้ในการก าหนดการอ้างอิงต าแหน่งข้อมูลในแนวตั้ง 
 
3. ส่วนประกอบต่างๆ ของ Work Sheet  
  Work Sheet เป็นพื้นที่ท างานท่ีเปรียบเสมือนเป็นกระดาษที่สามารถป้อนข้อมูลที่ต้องการลงไปได้ แต่ 
Work Sheet ของโปรแกรม Excel จะมีความสามารถเหนือกว่า กระดาษที่สามารถป้อนข้อมูลเท่านั้น เพราะ
สามารถที่จะแก้ไขข้อมูลได้ง่ายและค านวณได้ใน Work Sheet ด้วย ส่วนประกอบต่างๆ ของ Work Sheet ที่
ควรรู้จักมีดังนี้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 3 ชื่อส่วนประกอบต่างๆของ Work Sheet 

 
เซลล์ (Cell) เป็นช่องส าหรับใส่ขอ้มูล ภายในหน่ึงเซลล์จะมีข้อมลูได้เพียงแค่ตัวเดียว โดยข้อมูลจะเปน็ตัวเลข 
ตัวอักษร ข้อความ หรือสตูรต่างๆ  
ต าแหน่งกรอกข้อมลู (Active Cell)  ต าแหน่งกรอกข้อมูลจะเป็นเซลล์ที่มีกรอบเข้มกว่าเซลล์อื่นเป็นพิเศษ 
เซลล์นี้เป็นเซลล์ที่ผู้ใช้สนใจจะแกไ้ข หากผู้ใช้พิมพ์ข้อมูลลงไป เซลลน์ี้จะถูกแก้ไขทันทีคอลัมน์ (Column) คือ
ช่องข้อมูลที่เรียงอยู่ทางแนวตั้ง ใน Excel จะมีทั้งหมด 256 คอลัมน ์

 

ป้ายช่ือของ Work Sheet เซลล ์

ต าแหน่งกรอกขอ้มูล 
หวัแถว 

หวัคอลมัน ์
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หัวคอลัมน์ (Column Heading) คือช่ือแทนช่องข้อมูลที่อยู่ในแนวตั้ง ใน Excel จะใช้
ตัวอักษรภาษาอังกฤษเป็นช่ือคอลมัน์ เริ่มตั้งแต่ A, B, C-Z แล้วต่อดว้ย AA, AB ไปจนถึง IV 
แถว (row) คือ ช่องข้อมูลที่เรียงอยู่ทางแนวนอน ใน Excel จะมีแถวทั้งหมด 65,536 แถว 
หัวแถว (row Heading) คือ ช่ือของช่องที่อยู่ในแนวนอนเดียวกัน ใน Excel ใช้ตัวเลขแทนช่ือของแถว เริ่มไป
ตั้งแต่  1 ไปจนถึง 65,536 
ป้ายชื่อของเวิร์กชีต (Sheet Tab) ใช้แสดงช่ือของเวิร์กชีตที่ผู้ใช้ใช้งานอยู่ในขณะนี้ 

 

  
4. การออกจากการใช้งานโปรแกรม Microsoft Excel 

ในการออกจากโปรแกรม Excel สามารถด าเนินการดังนี ้

1.  คลิกเมนู File -> เลือกค าสั่ง Exit หรือ กดปุ่ม Alt + F4  หรือคลิกปุ่มควบคมุโปรแกรม     
เพื่อปิดโปรแกรม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 4 การออกจากโปรแกรม Excel 
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5. การสร้างงานใหม่  
ในการสร้างเอกสาร Excel เพื่อเริ่มต้นท างาน นั้นจะเรียกว่าเป็นการสร้าง WorkBook ใหม่ ซึ่งใน  

WorkBook ที่สร้างใหม่นี้ สามารถท่ีจะมี เอกสาร Work Sheet อยู่ภายใน WorkBook ได้หลายๆ Work Sheet    
การสร้างงานใหม่ดังนี้ 

1. คลิกท่ีเมนู File -> New  จะเกิดกลุ่มของแถบงานค าสั่งขึ้นด้านขวามือของหน้าจอ  ดังรูป 
 

 
รูปที่ 5 การสร้างงานใหม่โดยเลือกที่ Blank WorkBook 

 
2. ในส่วนแถบงานค าสั่ง New ให้คลกิเลือก Blank WorkBook เพื่อสรา้งงานใหม่  สังเกตที่ Title 

Bar จะมีช่ือของ WorkBook ใหม่ขึ้นมา เช่น Book1, Book2 ดังรูป   ท้ังนี้ข้ึนอยู่กับจ านวนการ
คลิก Blank WorkBook ของผู้ใช้   

 
 
 
 
 
 
 
 
 
 

รูปที่ 6 WorkBook ใหม่ท่ีเกิดขึ้นจากการคลิกเลือก Blank WorkBook 

 

ช่ือ WorkBookใหม่ ช่ือ Book1 
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6. การบันทึกข้อมูลและการเปิดแฟ้มข้อมลู 
ในการบันทึกข้อมูลของโปรแกรม Excel เหมือนกันกับโปรแกรม Word นั่นคอื สามารถที่จะบันทึก 

งานใหม่ ที่ยังไม่เคยมีการเก็บบันทึกมาก่อน และ สามารถบันทึกงานที่แก้ไขอยู่แล้วต้องการเปลี่ยนช่ือแฟ้มข้อมูล
ในช่วงเวลาที่ต้องการบันทึกได้  ปฏิบัติดังนี ้

6.1 การบันทึกงานใหม่ หรือบันทึกงานซ้ าท่ีแฟ้มข้อมูลชื่อเดิม 
1. คลิกเมนู File -> เลือกค าสั่ง Save  หรือกดปุ่ม Ctrl + S หรือ คลิกแถบเครื่องมือรูป 

          
 
 
 
 
 
 
 

 
รูปที่ 7 การเลือกค าส่ัง Save เพื่อบันทึกงานใหม่ หรือบันทึกงานซ้ าที่แฟ้มข้อมูลชื่อเดิม 

 
 
 
 
 
 
 
 
 
 
 
 

รูป การเลือกชนิดของเอกสารที่จะบันทึกให้เหมาะสม 
 

        รูปที่ 8 หน้าจอ Save As Dialog 

 
  จะปรากฏหน้าจอ Save As Dialogเพื่อให้ผู้ใช้ก าหนดรายละเอียดดังนี้ 
2.  ในช่อง File Name พิมพ์ช่ือไฟล์ที่ต้องการบันทึก 

 

 

new folder 



 โครงการแหลง่เรยีนรูย้คุดจิทิลั   8 

3.  ถ้าต้องการเปลี่ยน folder หรือ drive ใหม่  ในช่อง Savein คลิกที่▼ เพื่อเลือกต าแหน่งใหม่ที่
ต้องการ 

4. ถ้าต้องการสร้าง folder ใหม่ ให้คลิกที่ปุ่ม new folder  -> ใส่ช่ือ folder  -> ดับเบิ้ลคลิกที่ 
folder ใหม่ 

5. ในช่อง Save as type คลิกท่ี ▼ เพื่อเลือกรูปแบบของ WorkBook ที่ต้องการให้บันทึก โดยใน 
ช่อง Save as type ใช้ในการก าหนดให้เอกสารที่ท าการบันทึกสามารถท่ีจะน าไปใช้งานกับโปรแกรม Excelใน
เวอร์ชันที่ต้องการได้โดยข้อมูลภายใน WorkBook จะไม่เกิดปัญหาการเปลี่ยนของตัวหนังสือหรือ รูปแบบของ
เอกสารจะไม่มีการเปลี่ยนแปลงจากเดิม เช่น น าไปใช้กับ Excel เวอร์ชัน 97 หรือ Excel เวอร์ชัน 2000 เป็นต้น  
 

หมายเหตุ  หากผู้ใช้ทราบว่าโปรแกรม Microsoft Excel ที่ต้องการใช้งานเป็นเวอร์ชันเดียวกัน ก็ไม่จ าเป็นท่ีจะ 
 เลือกในตัวเลือกของ save as type  โดยปกติแล้วโปรแกรม Microsoft Excel เวอร์ชันท่ีใหม่กว่าจะ 
 เปิด WorkBook ที่ถูกสร้างจากโปรแกรม Microsoft Excel ที่เป็นเวอร์ชันต่ ากว่าได้  แต่เวอร์ชันต่ า 
 กว่าอาจจะไม่สามารถเปิด WorkBook ที่สร้างจากเวอร์ชันใหม่กว่าได้ถูกต้อง ส าหรับแฟ้มข้อมูลที่ถูก 
 บันทึกด้วยโปรแกรม Microsoft Excel จะมีนามสกุล  .xls 
 

6.  คลิกท่ีปุ่ม Save เพื่อท าการบนัทึก (หรือ คลิกท่ีปุม่ Cancel เพื่อยกเลิกค าสั่ง) 
 

6.2 การบันทึกงานขณะก าลังท างาน 
1.  คลิกท่ีเมนู File -> คลิก Save หรือ  คลิกท่ีปุ่ม Save บน Standard toolbar  หรือ กด Ctrl + S 

6.3 การบันทึกงานที่มกีารแก้ไขและต้องการเปลี่ยนชื่อแฟ้มข้อมูลเป็นชื่ออืน่  
1.  คลิกท่ีเมนู File -> คลิก Save As จะปรากฏกล่อง Save As Dialog บนหน้าจอ 
     หมายเหตุ  ขั้นตอนอ่ืนๆ ให้ปฏิบัติตามขั้นตอนของการบันทึกงานใหม่ 

6.4 การเปิดงานที่มีอยู่ 
1.  คลิกท่ีเมนู File -> คลิก Open หรือ คลิกท่ีปุ่ม Open บน  Standard toolbar หรือ กด  

Ctrl + O จะปรากฏกล่อง Open บนหน้าจอ 

2.  เปลีย่น folder หรือ drive ใหม่  ในช่อง Look in คลิกท่ี ▼ เพื่อไปยัง folder ทีไ่ฟล์อยู ่
3.  ดับเบิล้คลิกท่ีไฟล์ที่ต้องการ  หรือ  คลิกที่ไฟล์ทีต่้องการ -> คลกิท่ีปุ่ม Open 
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7. การสั่งพิมพ์เอกสาร 
1. คลิกเมนู File -> คลิก Print  หรือ กด Ctrl + P  จะปรากฏกล่อง Print dialog 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที่ 9  การสั่งพิมพ์เอกสาร 

 

2. ในส่วนของ Printer ช่อง Name คลิกท่ี ▼ เพื่อเลือกเครื่องพิมพ์ทีต่้องการ 
3. ในส่วนของ Print range เลือกหนา้เอกสารทีต่้องการพิมพ์  โดยที ่
o คลิก All  ถ้าต้องการพิมพ์ท้ังเอกสาร 
o คลิก Page(s) From: …  To:… เป็นการสั่งพิมพ์งานเป็นช่วงที่ต้องการโดยจะต้องก าหนดหน้า

เริ่มต้นในช่อง From  และก าหนดหน้าสิ้นสุดในช่อง To  เช่น ต้องการสั่งพิมพ์หน้า 1 หน้าเดียว 
สามารถสั่งให้พิมพ์ได้คือ ก าหนดให้ From: 1  To: 1  ก็จะสามารถสั่งพิมพ์เฉพาะหน้าที่ต้องการ
ได้     

4. ในส่วน Print What  เป็นส่วนท่ีสามารถก าหนดให้การพิมพส์ามารถท าได้สะดวกมากขึ้น มี 
ตัวเลือกดังนี ้

o คลิก Selection  ส าหรับการสั่งพิมพ์เฉพาะส่วนท่ีได้มีการท าแถบสหีรือเลือกไว้  
o คลิก Entire Workbook  ส าหรับสั่งพิมพ์ทุก Work Sheet ที่มีอยู่ใน WorkBook ที่เปิดอยู ่
o คลิก Active Sheet(s)  ส าหรับการสั่งพิมพ์เฉพาะ Work Sheet ที่ก าลั่งท างานอยู่เท่าน้ัน 

5. ในส่วน Copies  ที่ Number of Copies: คลิกท่ี ▲  ( หรือ ▼)  เพื่อก าหนดจ านวนส าเนาที ่
ต้องการพิมพ ์

6. ที่ตัวเลือก Collate เป็นการสั่งให้การพิมพ์ให้เอกสารออกเป็นชุดเรยีงหน้าที่ละชุด หรือพิมพ ์
เอกสาร แตล่ะหน้าให้ครบจ านวนส าเนาทีล่ะหน้า (ให้สังเกตที่รูปที่มกีารเปลีย่นแปลงด้วยเมื่อคลิก) 

7. คลิก OK เพื่อพิมพ์เอกสาร หรือ คลิก Cancel เพื่อยกเลิกการพิมพ ์
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8. การก าหนดค่าเร่ิมต้นให้กับ Work Sheet ที่จะท างาน (Page Setup) 
8.1 การก าหนดหน้ากระดาษและชนิดกระดาษ 
 1. คลิกเมนู File -> Page Setup จะปรากฏกล่อง Page Setup Dialog ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 10 การก าหนดหน้ากระดาษและชนิดกระดาษ 

 
 2.คลิกเลือกที่เมนูย่อย Page 
 3.ในส่วน Orientation จะให้ผู้ใช้เลือกรูปแบบของกระดาษ แนวตั้ง (Portrait) หรือแนวนอน  

(Landscape) 
4.ในส่วน Scaling สามารถให้ผู้ใช้ก าหนดการย่อหรือขยายขนาดของ Work Sheet ได้ทีส่่วนของ  

Adjust to: และในส่วน Fit to:  สามารถที่จะก าหนดให้ขนาดของความสูงของหน้าท่ีต้องการให้เป็นแบบคงที่ได ้
5.ในส่วน Paper size: สามารถให้ผู้ใช้ก าหนดขนาดของกระดาษที่ตอ้งการท างานได้ เช่น A4,  

Letter, Legal 
6. ในส่วน Print Quality: สามารถให้ผู้ใช้ก าหนดคณุภาพของการพิมพ์งานได้ (ขึ้นอยู่กับเครื่องพิมพ์ 

ด้วย) 
7. เมื่อก าหนดได้ตามต้องการแล้ว คลิก OK เพื่อให้ Excel ก าหนดตามที่ต้องการ หรือคลิก Cancel  

เพื่อยกเลิก 
 

8.2 หน่วยวัดของโปรแกรม Microsoft Excel 
หน่วยวัดที่ใช้ในโปรแกรม Excel นั้น จะไม่สามารถเปลี่ยนไปใช้หน่วยต่างๆ ได้เหมือนกับโปรแกรม  

Word โดยทั่วไปแล้ว หน่วยวัดในโปรแกรม Excel จะใช้หน่วยวัดเป็น นิ้ว (inch) ในการก าหนด Page Setup 
สังเกตว่าจะไม่มีการแสดงหน่วยวัดมาให้เห็น ดังนั้นจะต้องระวังในการก าหนดระยะต่างๆ ด้วย 
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8.3 การก าหนดระยะขอบของหน้ากระดาษ 
 1. คลิกเมนู File -> Page Setup จะปรากฏกล่อง Page Setup Dialog ขึ้น 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 11 การก าหนดระยะขอบของ Work Sheet 
 

 2. คลิกเลือกเมนูย่อย Margins 
 3. ท าการก าหนดระยะขอบท่ีต้องการ (อย่าลืมว่าตัวเลขท่ีก าหนดนีห้น่วยวัดเป็น นิ้ว) 
 4. ในส่วน Center On page เป็นการก าหนดใหต้ารางข้อมลูใน Work Sheet ให้อยู่ตรงกลางพ้ืนท่ี
กระดาษโดยสามารถก าหนดใหม้ีการอ้างอิงตามแนวตั้ง (Vertically) หรือให้อ้างอิงตามแนวนอน 
Horizontally) หรือให้มีการอ้างอิงทั้งตามแนวตั้งและแนวนอน ให้ผูใ้ช้คลิก      ในช่องสี่เหลี่ยมเพื่อ
ก าหนดการจดัตารางที่ต้องการ 
 5. คลิก OK เพื่อให้ Excel ก าหนดตามที่ต้องการ หรือคลิก Cancel เพื่อยกเลิก 
 
 

8.4 การก าหนดหัวกระดาษ (Header) และท้ายกระดาษ (Footer) 
 1. คลิกเมนู File -> Page Setup จะปรากฏกล่อง Page Setup Dialog ขึ้น 
 2. คลิกเลือกเมนูย่อย Header/Footer 

3.  เมื่อต้องการก าหนดในส่วนหัวกระดาษ โดยเลือกรูปแบบข้อความที่มีอยู่แล้วให้คลิกท่ี ▼  เพื่อ
เลือกรูปแบบข้อความที่ต้องการ  (ในการก าหนดท้ายกระดาษก็ปฏิบตัิเหมือนกันในส่วนตัวเลือก Footer)  
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รูปที่ 12  การก าหนดหัวกระดาษและท้ายกระดาษ 
 

4. หากต้องการก าหนดหัวกระดาษเอง ให้คลิกท่ีปุ่ม Custom Header  แล้วจะปรากฏกล่อง Header 
Dialog ดังนี ้

 

 
 
 
 
 
 
 

รูปที่ 13 ลักษณะของ Custom Header 
 

- สังเกตว่าจะมีส่วนที่ให้ผู้ใช้พิมพ์ข้อความ หรือก าหนดใส่หน้ากระดาษ วัน เหมือนกับการก าหนด
หัวกระดาษและท้ายกระดาษของโปรแกรม Word เพียงแต่ ในโปรแกรม Excel จะมีการแบ่ง
พื้นที่ให้พิมพ์เป็น 3 ส่วน คือ Left Section  เมื่อต้องการให้สิ่งที่พิมพ์ไปชิดซ้าย , Center 
Section  เมื่อต้องการให้สิ่งที่พิมพ์ไปอยู่ตรงกลางกระดาษ และ Right Section เมื่อต้องการให้
สิ่งที่พิมพ์ไปชิดขวา 

- Custom Header  และ Custom Footer มี Tool ที่ใช้แต่งดังนี ้

o    การก าหนดรูปแบบ และขนาดตัวอักษร 
o    Page(เลขหน้า)  &[Page] 

o    Pages(เลขหน้าท้ังหมด)  &[Pages] 

o    Date(วันท่ีเครื่อง)  &[Date] 

o    Time(เวลาเครื่อง)  &[Time] 

 

 

ตวัเลือกรูปแบบของขอ้ความท่ี
ตอ้งการปรากฎ 

ส่วนแสดงขอ้ความเม่ือมีการ
ก าหนดขอ้มูลใหแ้ก่ Header  
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o    พิมพ์ช่ือโฟลเดอร์และ Workbook 
&[Path]&[File]  

o    File(ช่ือFile)  &[File] 

o    Tab(ช่ือWorkSheet)  &[Tab] 

o     Picture(รูปภาพ)  &[Picture] 

o    ปรับแต่งรูปภาพ 

- เมื่อก าหนดหัวกระดาษให้ได้ตามต้องการแล้ว คลิกปุ่ม OK  หรือยกเลิก คลิกปุ่ม Cancel 
5. คลิก OK เพื่อให้ Excel ก าหนดตามที่ต้องการ หรือคลิก Cancel เพื่อยกเลิก 
 

9. เร่ิมต้นท างานกับ Work Sheet 
9.1 การต้ังชื่อให้กับ Work Sheet 

ในการท างานนั้นควรเปลีย่น Worksheet ให้สอดคล้องกับข้อมูลที่ปอ้น เพื่อช่วยให้เตือนความจ า
และท าให้การเรียกใช้ข้อมูลไดส้ะดวก วิธีเปลี่ยนช่ือ Work Sheet มีดังนี้ 
1. คลิกขวาท่ีแท็บชีตงานของ Work Sheet ที่ต้องการตั้งช่ือใหม่ 
2. คลิกค าสั่ง Rename  
3. พิมพ์ Work Sheet ใหม่ และกด Enter 

9.2 การใส่ข้อมูลลงในเซลล์ ที่อยู่ใน Work Sheet 
การใส่ข้อมูลลงในเซลล์ จะเหมือนกับการพิมพ์ข้อมูลที่ต้องการลงไปในเซลล์ทีต่้องการ ปฏิบัตดิังนี้ 
1. คลิกเซลล์ที่ต้องการป้อนข้อมูล 
2. ป้อนข้อมูลที่ต้องการลงในเซลล ์

 ข้อมูลตัวอักษร (ชิดซ้ายของเซลล,์ ค านวณไมไ่ด้) 

 ข้อมูลตัวเลข (ชิดขวาของเซลล,์ ค านวณได้)  
3. เมื่อป้อนข้อมูลจบแล้ว ให้กดแป้น enter หรือคลิกเมาส์ทีเ่ซลล์อื่น 

9.3 เทคนิคการปัดตัวหนังสือที่ยาวๆ ให้น าเสนอหลายๆ บรรทัดใน เซลล์เดียวกัน 
ในบางครั้งเมื่อป้อนข้อมูลที่มีความยาว เช่น ข้อความยาวๆ  แต่มีขนาดความกว้างของเซลล์จ ากัด
แต่ผู้ใช้ต้องการน าเสนอข้อความยาวๆ นั้นให้สามารถน าเสนอในช่องเซลล์ได้ครบถ้วนไม่ขาดหาย   
ปฏิบัติดังนี ้

o เมื่อพิมพ์ข้อมูลในบรรทัดแรกในเซลลไ์ปจนถึงขอบของเซลล์ ให้กดปุม่ Alt +enter  
o สังเกตจะมีการเลื่อนบรรทัดลงมาเป็นบรรทัดท่ีสอง แต่ยังอยู่ในเซลลเ์ดียวกัน  ดังรูป 
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     รูปที่ 14 แสดงลักษณะของเซลล์ท่ีมีข้อความยาวๆ ที่ใช้เทคนิคการกด Alt+enter เทียบกับเซลล์ท่ีไม่มีการใช้ 

 
10. การเลือกเซลล์ กลุม่เซลล ์ใน Work Sheet ที่ต้องการ 

10.1 การ Drag เมาส์เพ่ือก าหนดขอบเขตของข้อมูลที่ต้องการ 
การ Drag เมาส์ หรือการท าแถบสใีห้กับเซลล์ข้อมูลที่ต้องการจะมีวิธีการที่เหมือนกันกับการ

ท าแถบสีให้กับข้อความที่ต้องการในโปรแกรม Word  เพียงแต่ใน Excel จะเป็นกลุ่มของเซลล์
เท่านั้น มีวิธีปฏิบัตดิังนี ้

1. คลิกเมาส์ปุ่มซ้ายค้างไว้ทีเ่ซลล์เริ่มต้นที่ต้องการ  
2. ท าการลากเมาส์ (Drag) ผ่านเซลลท์ี่ต้องการท าแถบสี โดยยังไม่ปล่อยคลิก 
3. เมื่อ Drag เมาสไ์ปถึงเซลลส์ุดท้ายที่ต้องการแล้วจึงปล่อยคลิก  สังเกตเซลล์ที่ได้ท าการ Drag 

จะเกิดแถบสีขึ้น ดังรูป 
 
 
 
 
 
 
 
 
 
 

รูปที่ 15 กลุ่มเซลล์ท่ีได้ท าการ Drag เมาส์เพื่อท าแถบสี 

 

ขอ้ความยาวๆ ท่ีใช ้Alt+enter ขอ้ความยาวๆ ท่ีไม่ใช ้Alt+enter 
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 หากต้องการเลือกกลุ่มเซลล์ ท่ีไมต่ิดกัน สามารถใช้การ Drag เมาสร์่วมกับการ
กดปุ่ม Ctrl ค้างไว ้เพื่อ 
ท าให้สามารถด าเนินการ Drag เมาส์ยังกลุ่มเซลล์อื่นที่ต้องการได้ในครั้งเดียวกัน  ปฏิบตัิดังนี ้

1.Drag เมาส์กับกลุ่มเซลล์ทีต่้องการเลือกกลุ่มแรก 
2.กดปุ่ม Ctrl ค้างไว ้
3.Drag เมาส์กับกลุ่มเซลล์กลุ่มทีส่องหรือกลุ่มอื่นท่ีต้องการสังเกตจะเกิดแถบสีเป็นกลุ่มๆ ให้เห็นดังรูป 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 16 การ Drag เมาส์เลือกกลุ่มเซลล์ท่ีไม่ต่อเนื่องกัน ร่วมกับการใช้ปุ่ม Ctrl 

 
10.2 การเลือกทั้งแถว (Row) 

1. คลิกท่ีช่ือหัวแถวที่ต้องการเลือก สงัเกตจะเกดิแถบสีทั้งแถวที่เลือก  ดงัรูป 
 
 
 
 
 
 
 
 

 

รูปที่ 17 การเลือกกลุ่มเซลล์ท้ังแถว 
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10.3 การเลือกทั้งคอลัมน์ (Column) 

1. คลิกท่ีช่ือหัวคอลัมน์ท่ีต้องการเลือก สังเกตจะเกิดแถบสีทั้งคอลมัน์ทีเ่ลือก 
 
 
 
 
 
 
 

 
รูปที่ 18 การเลือกกลุ่มเซลล์ท้ังคอลัมน์ 

 
10.4 การเลือกข้อมลูทั้ง Work Sheet 

1. คลิกท่ีเซลล์มมุบนด้านซ้ายของจุดตัดกันของหัวแถวและหัวคอลัมน์ หรือกดปุ่ม Ctrl+A    
ดังรูป 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 19 การเลือกข้อมูลทั้ง Work Sheet 

 
11. การก าหนดคุณสมบัติเฉพาะให้กับเซลล์ในการแสดงค่าหรือทั้งกลุ่มของเซลล์ที่ต้องการ 

การก าหนดคณุสมบัตเิฉพาะให้กับเซลล์ เพื่อให้เซลล์นั้นรับข้อมูลที่ถูกต้องตามชนิดของข้อมูลและท า
ให้การแสดงผลทางหน้าจอมีความถูกต้องเหมาะสมตามที่ต้องการ  มีขั้นตอนปฏิบัตดิังนี้ 

 

 

คลิกท่ีตรงน้ี 
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1. ท าการ Drag เลือกกลุม่เซลล์ที่ต้องการ หรือคลิกเซลล์ที่ต้องการเพื่อให้เกิด
กรอบสี่เหลี่ยมเข้มล้อมรอบเซลล์ทีต่้องการ 

2. คลิกเมนู Format -> Cells  จะเกิด Format Cells Dialog  ดังรูป 

 
รูปที่ 20 การก าหนดคุณสมบัติของเซลล์ท่ีเกี่ยวกับการแสดค่าตัวเลขแบบต่างๆ 

 
3.  หากต้องการปรับคณุสมบตัิในการแสดงตัวเลขให้เป็นแบบต่างๆ  เช่นต้องการให้แสดงผลเป็นตัวเลข

ทศนิยม  2 ต าแหน่ง เช่น 100.50  ปฏิบัติดังนี ้
1. คลิกเมนูย่อย Number ->เลือก Category เป็นแบบ Number -> ในส่วน Decimal Places ให้

คลิกเลือกเป็นเลข 2  
2. หากต้องการให้ตัวเลขมีการใช้ comma คั่นเมื่อถึงหลักพัน ให้คลิกในกล่องของ use 1000 

Separators(,)  
3. หากต้องการให้เซลล์มีการแสดงเลขจ านวนลบในรูปแบบต่าง ให้คลิกเลือกรูปแบบได้ในส่ วน 

Negative Numbers  
4. คลิก OK เพื่อให้ Excel ก าหนดคุณสมบัติให้กับเซลล์ หรือ Cancel  เพื่อยกเลิก 
** ข้อสังเกต***  ในส่วนของการปรับคุณสมบัติ Number  จะมีส่วน Sample ใช้เพื่อแสดงลักษณะ
ของข้อมูลเมื่อได้เลือกรูปแบบ Number แต่ละ Category   

 
4.  หากต้องการปรับคณุสมบตัิในการจัดรูปแบบของข้อมูลในเซลล์ ให้ชิดซ้าย ชิดขวา อยู่ตรงกลาง ตา่งๆ 

หรือให้ข้อความเอียงไปตามองศาที่ต้องการ เพื่อให้เกิดความสวยงาม  ปฏิบัติดังนี ้

1.   คลิกเมนูย่อย Alignment  จะมตีัวเลือกที่จะพิจารณาดังนี ้
a. ส่วน Text alignment เป็นการก าหนดให้การจัดวางข้อความอ้างอิงต าแหน่งการจัดใน

แนวนอน(Horizontal) และแนวตั้ง (Vertical) ต าแหน่งไหนบ้าง โดยมีตัวเลือกคลิกเลือกได้ 
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b. ส่วน Orientation เป็นการก าหนดให้ข้อมูลที่อยู่ในเซลลม์ีการปรับเอียงเป็นองศาใดบ้าง จะอยู่
ในช่วง -90 ถึง 90 องศา 

c. ส่วน Text control เป็นการก าหนดให้รูปแบบของเซลล์ข้อมูลที่แสดงเป็นแบบต่างๆ เช่น คลิก 
Merge Cell จะน าเซลล์ที่ท าแถบสีทั้งหมดรวมเป็นเซลล์เดียวกัน 

2.  คลิก OK เพื่อให้ Excel ก าหนดคณุสมบัติให้กับเซลล์ หรือ Cancel  เพื่อยกเลิก 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 21  การก าหนดคุณสมบัติเซลล์ในการจัดวางรูปแบบของข้อมูลในเซลล์ 
 

5. หากต้องการปรับคณุสมบัติของตัวอักษรที่แสดงในเซลล์ให้เป็นรูปแบบต่างๆ ปฏิบัตดิังนี ้
1. คลิกเมนยู่อย Font มีตัวเลือกที่จะพิจารณาเหมือนกับ โปรแกรม Word ดังนี ้

a. ส่วน Font  เป็นส่วนท่ีใช้ก าหนดรปูแบบของตัวอักษร 
b. ส่วน Font Style เป็นส่วนท่ีใช้ก าหนดลักษณะของตัวอักษร ให้เป็นตัวหนา  (Bold), ตัวเอียง 

(Italic), ตัวปกติ (Regular) 
c. ส่วน Underline เป็นการก าหนดให้ข้อความมีการขีดเส้นใต้ โดยมตีวัเลือก 2 กลุ่มคือ เส้น

เดี่ยว (Single) และเส้นคู่ (Double) สังเกตค าที่มี Accounting ตามท้าย จะก าหนดให้ข้อมูล
ไม่ถูกเส้นใต้ขีดทับ 

d. ส่วน Color เป็นส่วนท่ีก าหนดสีให้กับตัวอักษรในเซลล์ตามต้องการ 
e. ส่วน Effect เป็นส่วนท่ีท าให้ตัวอกัษรเกิดลักษณะที่แตกต่างจากปกติ เช่น ตัวยก 

(Superscript) , ตัวห้อย (Subscript) และตัวที่มีขดีเส้นตัดกลางตัวอกัษรในแนวนอน 
(Strikethrough) 

2. คลิก OK เพื่อให้ Excel ก าหนดคุณสมบัติให้กับเซลล์ หรือ Cancel  เพื่อยกเลิก 
          ** สังเกต*ุ*  ในการปรับแต่ละส่วนให้ดู Preview ประกอบด้วย 
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Microsoft Excel 

 
 
 
 
 

 
 
 
 
 

 

รูปที่ 22 การก าหนดคุณสมบัติของตัวอักษรของข้อมูลในเซลล์ 
 

6. หากต้องการปรับคณุสมบัติของเซลล์ก าหนดกรอบ (Border) ให้แก่เซลล์ ปฏิบัติดังนี ้
1. คลิกเมนยู่อย Border มีตัวเลือกทีจ่ะพิจารณา ดังนี ้

a. ส่วน Presets มีตัวเลือกในการตีกรอบได้ 3 แบบ คือ none คือไม่มีการตีกรอบหรือยกเลิกการ
ตีเส้นกรอบ , Outline คือ ตีเส้นกรอบล้อมรอบกลุ่มข้อมูลที่เลือก และ Inside คือ ตีเส้นกรอบ
กับเส้นตัดของกลุ่มเซลล์ 

b. ส่วน Border เป็นส่วนท่ีก าหนดให้ผู้ใช้ตีเส้นเองโดยการคลิกเมาส์ในรูปที่ต้องการ สังเกตว่าจะ
มีขอบด้านที่เข้มด้านใด เมื่อคลิกก็จะตีเส้นให้กับเซลล์ด้านนั้นเช่นกัน 

c. ส่วน Line เป็นการก าหนดรูปแบบของเส้นท่ีน ามาตีกรอบได้ 
d. ส่วน Color เป็นส่วนที่ก าหนดสีให้กับเส้นกรอบที่ต้องการ แต่มีข้อก าหนดคือ ต้องมีการ

ก าหนดสีก่อนการตีเส้นกรอบ 
2. คลิก OK เพื่อให้ Excel ก าหนดคุณสมบัติให้กับเซลล์ หรือ Cancel  เพื่อยกเลิก 

 
 
 
 
 
 
 
 
 
 

รูปที่ 23 การก าหนดคุณสมบัติของเซลล์โดยการตีกรอบ 

 

 

ส่วนของเซลล์ที่แสดงให้เห็นเมื่อมี
การสั่งตีกรอบในแบบต่างๆ 
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7. หากต้องการปรับคณุสมบัติของเซลล์ก าหนดสีพื้นให้แก่เซลล์ ปฏิบัตดิังนี้ 
1. คลิกเมนยู่อย Patterns -> ในส่วน Cell Shading -> ก าหนดสีพื้นที่ต้องการ 
         ** หากต้องการใส่รูปแบบของพื้นสามารถเลือกได้ที่ Patterns 
2.  คลิก OK เพื่อให้ Excel ก าหนดคุณสมบัติให้กับเซลล์ หรือ Cancel  เพื่อยกเลิก 

 
 

 
 
 

 
 
 
 

 

รปูที่ 24 การก าหนดคุณสมบัติเซลล์ในการใส่สีพื้นให้กับเซลล์ที่ต้องการ 
 

เร่ิมท าการค านวณ กับ Ms Excel 
12. การใส่ข้อมูลตัวเลขให้แก่เซลล์ และเทคนิคการใส่ข้อมูลตัวเลขแบบ Fill โดยการให้ตัวเลขเลื่อนค่า

อัตโนมัติ 
การใส่ข้อมูลดิบให้กับเซลล์สามารถป้อนข้อมูลเข้าไปในเซลล์ได้เหมือนกับการป้อนข้อมูลตัวเลข หรือ

ข้อความทั่วไป แต่ก่อนท่ีจะมีการค านวณ จ าเป็นที่จะต้องมีข้อมูลดิบนี้เสียก่อน หากพิจารณาลักษณะข้อมูล
ดิบที่จะต้องสร้างใน Work Sheet แล้วเห็นว่าเป็นกลุ่มตัวเลขที่มีค่าที่เรียงล าดับต่อเนื่องกัน อาจเป็นตาม
แนวนอน หรือตามแนวตั้ง  มีวิธีการสร้างข้อมูลดิบที่เป็นลักษณะตัวเลขที่มีความต่อเนื่องกันนั้นได้ง่าย โดย
การปฏิบัติดังนี้ 
 1. พิมพ์ข้อมูลดิบที่เป็นตัวเลขลงในเซลล์เริ่มต้นนั้น 

 2. คลิกเมาส์ที่เซลล์ที่มีข้อมูลตัวเลข -> เลื่อนเมาส์มาที่มุมล่างด้านขวาของเซลล์คลิกซ้ายค้างไว้  
      ->กดปุ่ม Ctrl ค้างไว้  -> Drag เมาส์ลงมาในแนวดิ่ง (คอลัมน์เดียวกัน) หรือในแนวนอน (แถว

เดียวกัน)  
     เพื่อให้ค่าตัวเลขที่จะใส่ในเซลล์ใหม่ที่เมาส์ Drag ผ่านมีค่าที่ถูกสร้างอัตโนมัติมีค่าต่อจากข้อมูล

เริ่มต้นโดยจะเพิ่มค่าทีละ 1 ไปเรื่อยๆ  ตามจ านวนของเซลล์ที่ Drag ผ่าน -> ปล่อยคลิกเมื่อถึงต าแหน่งที่
ต้องการจบการสร้างข้อมูล 
** สังเกต**  เมื่อกดปุ่ม Ctrl สังเกตที่เมาส์จะมเีครื่องหมายบวก (+) เล็กๆ  เพื่อรอการเพิ่มค่าข้อมลูทลีะ  
     1   อัตโนมัติ      

ตัวอย่าง เมื่อก าหนดเซลล์เริ่มต้น A1 มีข้อมูล 15 อยู่เพียง 1 ช่อง เมื่อสร้างข้อมลูแล้วทั้งแนวตั้งและแนวนอน 
จะไดผ้ลดังรูป 
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Microsoft Excel 

 
 
 
 
 
 

          
 
 
 
 

 
 

รูปที่ 25 ลักษณะของข้อมูลดิบที่มีการใช้เทคนิคการ Fill ข้อมูลแบบอัตโนมัติ 

 
จากการการใส่ข้อมลูตัวเลขแบบ Fill โดยการให้ตัวเลขเลื่อนค่าอัตโนมัติ ข้างต้น มีอีกวิธีหนึ่งในการใส่
ข้อมูลอัตโนมัติ (Auto Fill) มีวิธกีารดังนี้ 

1. พิมพ์ข้อมูลต้นฉบับ 1 Cell  ถ้าเป็นตัวเลขล าดบัพิมพ์ 2 Cell 
2. เลือกต้นฉบับ 
3. เลื่อนเมาส์ไปมุมล่างขวาตรงจุดสี่เหลี่ยมจนเมาส์เปลี่ยนเป็น +  
4. คลิก drag ลง/ ข้ึน/ ขวา/ ซ้าย ตามต้องการ 

ตัวอย่างพิมพ์ข้อมูลเริ่มต้น   จ.  ท าตามขั้นตอนดังกล่าวจะได้   อ.  พ.  พฤ.  ศ.  ส.  อา. 
   ม.ค. ท าตามขั้นตอนดังกล่าวจะได้   ก.พ.  มี.ค.  เม.ย.  ... 
   Jan ท าตามขั้นตอนดังกล่าวจะได้   Feb  Mar ... 
   1  2 ท าตามขั้นตอนดังกล่าวจะได้   3  4  5  ... 
 
13. การพิจารณาถึงช่วงข้อมูลที่สนใจ (Range of Data) ส าหรับการน ามาค านวณ 

a. การใช้เคร่ืองหมาย : (Colon) เพ่ือระบุถึงช่วงของข้อมูลที่ต้องการ 
ในการอ้างถึงช่วงข้อมูล (Range) ที่ต้องการส าหรับน ามาค านวณ สามารถน าช่ือเซลล์ และ         

เครื่องหมาย : (Colon) มาใช้ร่วมกัน มีรูปแบบดังนี ้
 
ต าแหน่งเร่ิมต้นของกลุ่มข้อมลู  :  ต าแหน่งสุดท้ายของกลุม่ข้อมลู 
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เช่น กลุ่มข้อมูลเริ่มที่เซลล์ A1  ถึงเซลล์  B5  สามารถเขียนช่วงข้อมลูนี้คือ 1:B5   ดังรูป 
 
 
 
 
 
 
 
 
 

รูปที่ 26 แสดงการอ้างถึงช่วงของข้อมูล โดยใช้เครื่องหมาย Colon 

 
14. การค านวณภายใน Work Sheet เดียวกัน 

a. การค านวณพ้ืนฐาน  (จะต้องมีเคร่ืองหมาย = ) 
ในการก าหนดให้โปรแกรม Excel ท าการค านวณค่าที่ต้องการได้นั้น จะต้องมีการป้อนสูตรเข้าไป

ให้แก่เซลล์ที่ต้องการให้มีการค านวณ ซึ่งเซลล์นั้นจะต่างกับเซลล์ข้อมูลทั่วไปตรงที่เซลล์ที่จะมีการค านวณจะต้อง
มีเครื่องหมาย = อยู่ในเซลล์ข้อมูลด้วยโดยจะอยู่ที่ชิดซ้ายของเซลล์นั้นๆ เสมอ แล้วถัดจากเครื่องหมาย = จะเป็น
สูตรต่างๆ ที่ใช้ในการค านวณเพื่อให้ได้ผลลัพธ์ตามต้องการ  เครื่องหมาย = จะเป็นสิ่งที่บอกให้โปรแกรม Excel 
รู้ว่าเมื่อมีผลลัพธ์ท่ีได้จากการค านวณของเซลล์นี้แล้วจะส่งผลลัพธ์ที่ได้ ผ่านเครื่องหมาย = แสดงออกมาที่เซลล์
นั้นๆ    

- เคร่ืองหมายทางคณิตศาสตร์ที่ใช้ในการค านวณที่ควรรู้ 
ในการค านวณของ โปรแกรม Excel นั้นสามารถน าเครื่องหมายทางคณิตศาสตร์พื้นฐานมาใช้

ร่วมกับการก าหนดสูตรเพื่อค านวณได้ นอกเหนือจากนั้นโปรแกรม Excel ยังมีฟังก์ชันส าเร็จรูปที่สามารถ
น ามาใช้ในการค านวณได้อย่างสะดวกและไม่ซับซ้อน  เครื่องหมายคณิตศาสตร์ทีใ่ช้ใน Excel มีดังนี้   

เครื่องหมาย  +  (บวก) เช่น = A1+A2  
เครื่องหมาย  -  (ลบ) เช่น = B5-F5 
เครื่องหมาย  *  (คูณ) เช่น = E8*A3 
เครื่องหมาย  /   (หาร) เช่น = D5-D1 
เครื่องหมายติดลบ (Unary Operator) เช่น  = -A10 
เครื่องหมาย ^  (ยกก าลัง) เช่น = A1^A5   

- การค านวณโดยการหาผลรวม (summation) 
ส าหรับการค านวณเพื่อหาผลรวมของกลุ่มตัวเลขท่ีต้องการ สามารถน าเครื่องหมาย บวก มาใช้

ร่วมกับการอ้างถึงช่ือเซลล์ที่ต้องการน ามาหาผลรวม คิดเหมือนการตั้งสมการผลบวกของตัวแปรนั่นเอง  มีวิธี
ปฏิบัติดังนี ้
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     ตัวอย่าง หาผลรวมของกลุ่มเซลล์ A1, A3, B1, B5 และ B6  แสดง
ผลลัพธ์ที่เซลล์ D1 
 1. คลิกเซลล์ที่ต้องการให้แสดงผลลัพธ์ 
 2. ป้อนสูตร = A1+A3+B1+B5+B6 ลงไปในเซลล์ D1 ซึ่งการป้อนสูตรสามารถป้อนได้ 2 
ทาง ดังนี้ 
  - ป้อนสูตรโดยพิมพ์ไปท่ีเซลล์ D1  
  - ป้อนสูตรโดยพิมพ์ไปท่ีแถบสูตร แต่ทั้งนี้ต้องน าเมาส์คลิกท่ีเซลล์ D1  
    ก่อนการพิมพ์สูตร 
  ** สังเกต ** เมื่ออ้างถึงช่ือเซลล์ในสูตรจะเกิดกรอบสีล้อมรอบเซลล์           
                            นั้นๆ เพื่อให้ผู้ป้อนเห็นว่าเป็นเซลล์ที่เลือก 
 3. เมื่อป้อนสูตรเสร็จแล้ว ให้กดปุ่ม enter เพื่อจบการป้อนข้อมลู  ลักษณะดังรูป 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 27 การป้อนสูตรส าหรับการหาค่าผลรวมของกลุ่มเซลล์โดยใช้เครื่องหมายคณิตศาสตร์ 

 
b. การค านวณโดยใช้ฟังก์ชันของ โปรแกรม Excel 

- การเรียกใช้ฟังก์ชันของ Ms Excel ข้อสังเกตในการใช้ฟังกช์ันจาก Insert Function 
Dialog ส าหรับการใช้งาน เพ่ือการศึกษาด้วยตัวเอง 

เมื่อผู้ใช้สามารถที่จะก าหนดให้เซลล์ของ Excel ท าการค านวณแบบพื้นฐานโดยสูตรใช้
เครื่องหมายทางคณิตศาสตร์ได้แล้ว แต่บางครั้งการค านวณจะกระท ากับข้อมูลที่มีขนาดใหญ่และมีการอ้างถึงช่ือ
เซลล์ที่มีจ านวนมาก อาจท าให้การพิมพ์สูตรมีความยาวและเกิดข้อผิดพลาดขึ้นได้ง่าย  โปรแกรม Excel ได้มี
การออกแบบฟังก์ชันส าหรับอ านวยความสะดวกในการค านวณมาให้มากมายเพื่อให้เลือกใช้ได้อย่างเหมาะสมกบั

ป้อนสูตรผา่นแถบสูตร 

ป้อนสูตรท่ีเซลล ์D1 โดยตรง 
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งานที่ต้องการ แต่ทั้งนี้ก่อนที่จะมีการใช้ฟังก์ชันของ Excel จ าเป็นที่จะต้องรู้วิธีการใช้งานฟังก์ชันของ Excel 
ร่วมกับการค านวณ  มีข้อปฏิบัติดังนี้ 
1. คลิกเมนู Insert -> คลิก Function    จะเกิด Insert Function Dialog ดังรูป 

 
 
 
 
 
 
 
 
 
 
รูปที่ 28 แสดงส่วน Insert Function Dialog 
 

ในส่วน Search for a function:  เป็นส่วนที่ผู้ใช้สามารถพิมพ์ค าส าคัญที่ใช้บอกให้  Excel 
ค้นหาฟังก์ชันที่เกี่ยวข้องกับค าส าคัญนี้  หากผู้ใช้พิมพ์เสร็จ  ให้คลิกปุ่ม Go  หาก Excel ค้นหาฟังก์ชันที่
เกี่ยวข้องกับค าส าคัญที่ป้อน ก็จะแสดงผลลัพธ์เป็นช่ือฟังก์ชันให้ผู้ใช้เลือก   เช่น ป้อนค าส าคัญลงไป คือ 
Summation ผลที่ได้จะปรากฏที่ช่อง Select a function เป็นช่ือฟังก์ชัน SUM และให้สังเกตที่ Or select a 
category นั้น จะแสดงเป็นค าว่า แนะน า (Recommended)  ดังรูป 

 
 
 
 
 
 
 
 
 
 
 
    

 

           รูปที่ 29 แสดงการป้อนค าส าคัญ summation เพื่อให้ Excel ค้นหาฟังก์ชันที่เกี่ยวข้องให้ 

 

 

 

แสดงโครงสร้างของฟังกช์นั อาร์กิวเมน
ของฟังกช์นั และค าอธิบายหนา้ท่ีฟังกช์นั 
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ในส่วน Or select a category:  เป็นกลุ่มประเภทของสายงานที่ผู้ใช้
ต้องการหรือเกี่ยวข้อง เช่น Statistic, Accounting เป็นต้น  เมื่อเลอืกประเภทของสายงานแล้ว ในสว่นของ 
select a function จะปรากฏช่ือของฟังก์ชันที่เกี่ยวกับสายงานนั้นออกมาให้เลือก 

** ใต้ช่องแสดงผล select a function นั้นจะเห็นว่าเป็นเหมือนกับ การแสดงโครงสร้างของ
ฟังก์ชัน ที่ผู้ใช้สามารถท่ีจะดูรูปแบบว่าฟังก์ชันจะมีการรับคา่อย่างไร และฟังก์ชันท าหน้าท่ีอะไรได้ ซึ่งตรงนี้จะมี
ประโยชน์ต่อผู้ใช้ ในกรณีที่ต้องการใช้ฟังก์ชันใหม่ๆ ท่ีไม่เคยเรียนในห้อง หรืออาจารย์ไม่ได้สอน ก็สามารถจะ
ศึกษาใช้งานด้วยตัวเองได ้

ในส่วน Help on this function  เป็นส่วนท่ีแสดงถึงตัวช่วยเหลอืในกรณีที่ผู้ใช้ต้องการเรียนรู้
ถึงตัวอย่างการใช้ฟังก์ชันท่ีได้คลิกเลือกเพื่อท าความเข้าใจ ได ้

 
2.  เมื่อคลิกเลือกแล้วพบฟังก์ชันท่ีต้องการแล้ว ให้คลิกปุม่ OK เพื่อด าเนินการใช้ฟังก์ชันนั้นต่อไป 
ค านวณหาค่าผลรวมโดยใช้ฟังก์ชัน SUM 

ตัวอย่าง  ต้องการหาค่าผลรวมของ เซลล์ A1, A3, B1 ,B5 และ B6 โดยการใช้ฟังก์ชัน 
1. ผู้ใช้จะต้องรู้ว่าต้องการท างานอะไรอยู่ขณะนี้เพื่อน ามาพิจารณาเลือกฟังก์ชันให้เหมาะกับความ

ต้องการ จากตัวอย่าง ต้องการหาค่าผลรวม ค าส าคัญที่น าไปใช้ในการหาฟังก์ชันได้คือ Summation, Sum   
2. คลิกเมนู Insert -> Function  แล้วป้อนค าส าคัญ Summation หรือ sum ลงในส่วน search -> 

คลิกปุ่ม GO 
3. ดูในส่วน select a function จะเห็นมีฟังก์ชันช่ือ SUM  และมีรูปแบบการใช้งานพร้อมค าอธิบาย

หน้าท่ีของฟังก์ชัน  ให้คลิกที่ฟังก์ชัน SUM  
4. คลิกปุ่ม OK  จะเกิด  Function Argument Dialog  เพื่อให้ผู้ใช้ป้อนค่าลงในฟังก์ชัน ดังรูป 

 
 
 
 
 
 
 
 
 
 

                           
รูปที่ 30 แสดงการป้อนอาร์กิวเมนต์ให้กับฟังก์ชัน SUM 
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5. ในช่อง SUM ให้พิมพ์อาร์กิวเมนต์ลงในช่องข้อมูล Number1 หรือ Number2  แต่ข้อมูลทีต่้องการให้
ฟังก์ชันค านวณมีมากกว่า 2 จ านวน ในช่อง Number1 สามารถรับค่าอาร์กิวเมนต์ได้มากกว่า 1 ตัว แต่การแยก
อาร์กิวเมนต์แต่ละตัวให้ใช้เครื่องหมาย ( , ) comma เป็นตัวคั่น 

6. เมื่อป้อนอาร์กิวเมนต์เสร็จ ให้กดปุ่ม OK เพื่อจบการท างาน   ผลลัพธ์จะได้ดังรูป 
7. เมื่อน าเมาส์คลิกที่เซลล์ D1 จะได้ผลลัพธ์ปรากฏขึ้น และที่แถบสูตรแสดงสูตรที่ใช้ฟังก์ชัน SUM ให้

เห็น 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที ่31 แสดงสูตรที่ได้จากการใช้ฟังก์ชั่น SUM ในการค านวณหาผลรวมของกลุ่มเซลล์ที่ต้องการ 

 
ฟังก์ชันพื้นฐานที่ควรรู้จัก 

 sum   ฟังก์ช่ันส าหรับการหาผลรวมของกลุ่มตัวเลขท่ีก าหนดให ้
 max  ฟังก์ชันส าหรับการหาค่ามากท่ีสุดในกลุ่มข้อมลูที่ก าหนดให ้
 min  ฟังก์ชันส าหรับการหาค่าน้อยที่สุดในกลุม่ข้อมูลที่ก าหนดให ้
 average  ฟังก์ชันส าหรับการหาคา่เฉลี่ยของกลุม่ข้อมูลที่ก าหนดให ้
 if  ฟังก์ชันส าหรับการพิจารณาเงื่อนไขตัดสินใจทางตรรกะ 
 now  ฟังก์ชันส าหรับการแสดงวันเดือนปีและเวลาปจัจุบันของระบบออกมา 
 today  ฟังก์ชันส าหรับการแสดงวนัเดือนปีปัจจุบันของระบบออกมา 
 day  ฟังก์ชันส าหรับการแสดงหมายเลขวันท่ีออกมา 
 month  ฟังก์ชันส าหรับการแสดงหมายเลขเดือน 1 ใน 12 เดือนออกมา 
 year  ฟังก์ชันส าหรับการแสดงปอีอกมา 
 weekday ฟังก์ชันส าหรับการแสดงหมายเลขวัน 1 ใน 7 วันออกมา(เช่น วันพุธ มีค่า 4) 
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             หมายเหตุ     ในการพิมพ์ช่ือเซลล์ หรือช่ือฟังก์ชันเป็นตัวอักษรพิมพ์เล็กหรือ
พิมพ์ใหญ่นั้น โปรแกรม Excel จะถือว่ามีความหมายเดียวกัน ไม่มผีลต่อการท างานของ Excel   เช่น  A1  มี
ความหมายเหมือนกับ a1 

 
c. การอ้างอิงต าแหน่งของเซลล์ ร่วมกับการใช้ฟังก์ชนัในการค านวณ 

 การอ้างถึงต าแหน่งของ Excel ส าหรับน าข้อมลูมาค านวณ สามารถอ้างได้ 2 แบบ ดังนี ้
1.  แบบสัมพัทธ์ (Relative)   

เป็นการอ้างอิงต าแหน่งข้อมูลโดยต าแหน่งของข้อมูลเมื่อท าการส าเนาไปให้เซลล์อื่นแลว้จะมี
การเปลี่ยนแปลงต าแหน่งไปด้วยโดยที่สูตรไม่มีการเปลี่ยนแปลง  เช่น   เซลล์ต้นฉบับที่มีสูตรสมการที่ต้องการ
ท าส าเนา อยู่ที่ต าแหน่ง  C1  ภายในเซลล์มีสูตรการรวมกันของข้อมูลที่ติดกัน 5 เซลล์ คือ ช่วง A1:A5   จะได้
สูตร คือ =sum(A1:A5) ดังรูป   

 
 
 
 
 
 
 
 

 

รูปที่ 32 แสดงการใช้ฟังก์ชันSUM โดยเป็นเซลล์ต้นฉบับ 

 
เมื่อต้องการส าเนาสูตรโดยอ้างอิงต าแหน่งแบบ Relative ไปยังต าแหน่ง C2  ผลที่ได้ Excel  

จะท าการเปลี่ยนต าแหน่งอ้างอิงของข้อมูล โดย C2  อ้างอิงสูตรจากเซลล์ C1 ซึ่ง C2 เลื่อนลงมาถัดจากเซลล์ 
C1 ไป 1 แถว ดังนั้นในสูตรของ เซลล์ C2 ก็จะเลื่อนต าแหน่งลงมา 1 แถวเช่นกันแต่ก็ยังเป็นการรวมกันของ
ข้อมูลที่ติดกัน 5 เซลล์เหมือนสตูรต้นฉบับ ดังนั้นสูตรที่เซลล์ C2 ที่ได้คือ  =sum(A2:A6) ดังรูป   
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รูปที่ 33 แสดงการใช้ฟังก์ชันSUM โดยการอ้างอิงต าแหน่งแบบ Relative 

2. แบบสมบูรณ์ (Absolute) 
เป็นการอ้างอิงต าแหน่งโดยที่ต้องการก าหนดให้ต าแหน่งที่ต้องการอ้างถึงในสูตรไม่มีการ

เปลี่ยนแปลงต าแหน่งไปเป็นต าแหน่งอื่นเมื่อท าการส าเนาไปวางยังต าแหน่งใดใน Work Sheet ก็จะยังคงอ้างถึง
ต าแหน่งเดิมเสมอ ซึ่งการอ้างอิงต าแหน่งแบบ Absolute นี้จะต้องมีการใช้เครื่องหมาย $  มาก าหนดให้ส าหรับ
บอกให้ Excel  ทราบว่า เมื่อใดที่มีเครื่องหมาย $ วางไว้หน้าต าแหน่งแถว (row) หรือ วางไว้หน้าต าแหน่ง
คอลัมน์ (column) แล้ว แสดงว่าแถวหรือคอลัมน์นั้นจะไม่มีการเปลี่ยนแปลงต าแหน่ง  

เช่น  ต้องการก าหนดให้ ต าแหน่งของเซลล์เป็นคอลัมน์ A เสมอไม่วา่จะส าเนาไปวางยังเซลล์
ใดๆ แต่แถวสามารถเปลี่ยนแปลงได้ สามารถก าหนดได้  คือ   $A1   

ต้องการก าหนดให้ ต าแหน่งของเซลลเ์ป็นคอลมัน์ใดๆ ก็ได้แต่แถวตอ้งการก าหนดให้เป็นแถวท่ี 
2 เสมอ ไม่ว่าจะส าเนาไปวางยังเซลล์ใดๆ สามารถก าหนดได้ คือ A$2 

ต้องการก าหนดให้ต าแหน่งของเซลล์เป็นคอลัมน์ A และแถวต้องการก าหนดให้เป็นแถวที ่1  
เสมอ ไม่ว่าจะส าเนาไปวางยังเซลล์ใดๆ สามารถก าหนดได้คือ $A$1 
   

ประโยชน์ของการอ้างอิงต าแหน่งแบบ Absolute เช่น ต้องการบวกค่าคงที่ที่อยู่ในต าแหน่ง E7 ให้กับ
เซลล์ D1 ที่มีสูตรหาผลรวมของข้อมูลช่วงเซลล์ A1:C1   ดังนั้นจะได้สูตรคือ  = sum(A1:C1)+$E$7   เมื่อท า
ส าเนาไปสูตรของเซลล์ D1 ไปยังเซลล์ D2 สูตรที่ได้ในต าแหน่ง D2 คือ = sum(A2:C2) +$E$7 สังเกตในสูตร
ต าแหน่งที่ไม่มีการใส่เครื่องหมาย $ ก ากับหน้าต าแหน่งคอลัมน์หรือแถวจะมีการเปลี่ยนแปลงต าแหน่งไป แต่ที่
ต าแหน่ง E7 ที่อ้างอิงเป็นแบบ Absolute ก็ยังคงเป็นต าแหน่งเดิมไม่มีการเปลี่ยนแปลง   ดังรูป 

 
 
 
 

 
 
 

 

รูปที่ 34  แสดงการอ้างอิงต าแหน่งแบบสมบูรณ์ 

  
15. การสร้างกราฟ (Chart) ใน Ms Excel  

a. สิ่งที่ต้องพิจารณาก่อนการสร้างกราฟ 
ในการสร้างกราฟใน Excel สิ่งส าคัญที่ต้องพิจารณา คือ ข้อมูลที่จะน ามาสร้างกราฟ ,ลักษณะ

ข้อมูลที่จะน ามาสร้างกราฟ และชนิดของกราฟท่ีต้องการน าเสนอ 
b. เมื่อเลือกค าสั่ง chart สิ่งที่ต้องรู้จัก และขั้นตอน 4 ขั้นตอน 
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การสร้างกราฟท าดังนี ้    
1. ให้ด าเนินการเลือกกลุ่มข้อมูลจะน ามาสร้างกราฟโดยท าแถบสี (Highlight) 

2.  คลิกแถบเมนู insert -> chart   หรือคลิกท่ีแถบเครื่องมือ สญัลกัษณ์    
 
 
 
 
 
 
 
 
 
 

รูปที่ 35  การเรียกค าส่ังในการสร้างกราฟ 

 

- จะปรากฏเป็นตัวช่วยในการสร้างกราฟเข้าสู่ขั้นตอนท่ี 1  Chart Type ดังรูป 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 36 ขั้นตอนที่1 ของการสร้างกราฟ 
 

ให้คลิกเลือกรูปแบบของกราฟมาตรฐาน (Standard Types) ที่ผู้ใช้ต้องการในส่วนของ Chat type เช่น 
ต้องการสรา้งกราฟเชิงเส้น (line)  แล้วด้านขวามือ เป็นการเลือกรูปแบบย่อยของกราฟแท่งที่ต้องการ (Chart 
sub-type) เพื่อให้เหมาะกับที่ต้องการน าเสนอ เช่น ต้องกราฟเชิงเสน้ท่ีมีการก าหนดจุดของค่าบนกราฟด้วย  
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ในขั้นตอนท่ี 1 นี้จะมีปุ่ม Press and Hold to View Sample เพื่อให้ผู้ใช้ดูลกัษณะของกราฟท่ีเลือก
เพื่อตัดสินใจที่จะท าขั้นตอนต่อไป โดยผู้ใช้ต้องคลิกปุม่นี้ค้างไว้ กราฟตัวอย่างจึงจะปรากฏขึ้น เมื่อปลอ่ยคลิก 
กราฟตัวอย่างก็จะเปลี่ยนเป็น Chart sub-type ตามเดิม ดังรูป 

 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 37 การสร้างกราฟขั้นตอนที่1 เมื่อคลิกปุ่ม Press and Hold to View Sample 

 
- คลิกปุ่ม Next >  เพื่อเข้าสู่ขั้นตอนที่ 2  Chart Source Data  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 38  การสร้างกราฟขั้นตอนที่ 2 
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ในขั้นตอนที่ 2 นี้จะให้ผู้ใช้เลือกข้อมูลที่จะน ามาสร้างกราฟซึ่ง  ได้ก าหนดช่วงของข้อมูล (Data range) 

ตั้งแต่แรกก่อนที่จะสร้างกราฟแล้ว จึงท าให้ ช่อง Data range : ปรากฎเป็นช่วงของข้อมูลให้เห็น แต่ถ้าผู้ใช้ไม่ได้
ก าหนดช่วงของข้อมูลมาก่อนการสร้างกราฟ ก็สามารถระบุช่วงของข้อมูลได้ในข้ันตอนน้ี ด้วยการพิมพ์ช่วงข้อมูล
ในช่อง Data range หรือใช้เมาส์ลากก าหนดขอบเขตของข้อมูลก็ได้  

ในส่วนของ Series in นั้น เป็นตัวเลือกที่ให้ผู้ใช้ระบุถึงลักษณะข้อมลูที่ต้องการให้แกน X น าเสนอโดยใช้
ค่าใด  เช่น     Series in Rows   -> ให้ Row แรกของกลุ่มข้อมูล เป็นข้อมูลแกน X    

Series in Column -> ให้ Columns แรกของกลุ่มข้อมลู เป็นข้อมูลแกน X 
           

จากรูปสังเกตว่าเลือก Series in Rows  ได้กราฟท่ีแกน X แสดงข้อมูลเป็นวัน ให้เห็น 
หากผู้ใช้ต้องการน า Series เพิ่มเขา้มา หรือน าออก ต้องคลิกเลือกที่เมนูย่อย Series ซึ่งจะท าหน้าที่ใน

การจัดการเกี่ยวกับการก าหนด Series ของข้อมูล  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

รูปที่ 39  การสร้างกราฟขั้นตอนที่ 2  เมนูย่อย Series 
 

ในส่วนของเมนูย่อย  Series นี้จะมีช่องที่ให้ผู้ใช้ก าหนดค่า ดังน้ี 
 Name  แสดงต าแหน่งเก็บช่ือ Series ใน Work Sheet สามารถเปลี่ยนแปลงได ้
 Value แสดงต าแหน่งเก็บค่าใน Work Sheet สามารถเปลี่ยนแปลงได ้
 Category(x) axis label  แสดงต าแหน่งช่ือในแกน X 

 
 
 



 โครงการแหลง่เรยีนรูย้คุดจิทิลั   32 

 
  -  คลิกปุ่ม Next > เพื่อเข้าสู่ขั้นตอนที่ 3 Chart Options ดังรูป 

 
 
 
 
 
 

 
 
 
 

รูปที่ 40  การสร้างกราฟขั้นตอนที่ 3 
 

ในส่วนที่ 3 นี้จะมีหลายเมนูย่อยซึง่ผู้ใช้สามารถก าหนดรายละเอียดให้กับกราฟไดด้ังนี้ 
เมนูย่อย Titles  เกี่ยวกับการก าหนดชื่อกราฟ ช่ือแกนของกราฟ  ประกอบด้วย 

 Chart Title:   ใส่ชื่อกราฟ หรือข้อความอธิบายกราฟ 

 Category (X) axis: ใส่ข้อความอธิบายแกน X 

 Category (Y) axis: ใส่ข้อความอธิบายแกน Y  
เมนูย่อย Axes เกี่ยวกับการก าหนด แกนหลัก Primary axis ประกอบด้วย 

 Category (X) axis: ก าหนดให้มีการแสดงหรือไม่แสดงค่าในแกน X ตามรูปแบบ 
Automatic; Category หรือ Time-scale 

 Value (Y) axis: ก าหนดให้มีการแสดงหรือไม่แสดงค่าในแกน Y 
เมนูย่อย Gridlines เกี่ยวกับการก าหนดเส้นตัดแกนเพื่อให้อ่านกราฟได้สะดวกประกอบด้วย 

 Category (X) axis: แสดงเส้นตัดแกน X ทั้งเส้นตัดแกนหลัก (Major gridlines) หรือเสน้ตัด
แกนรอง (Minor gridlines) 

 Category (Y) axis: แสดงเส้นตัดแกน Y ทั้งเส้นตัดแกนหลัก (Major gridlines) หรือเสน้ตัด
แกนรอง (Minor gridlines) 

เมนูย่อย Legend  เกี่ยวกับการแสดงค าอธิบายกราฟแต่ละจุดหรือแต่ละคา่ ประกอบด้วย 

 Show legend  ก าหนดให้แสดงหรือไม่แสดงค าอธิบาย 

 Placement:  ก าหนดการจดัวางต าแหน่งของค าอธิบาย ด้านล่างกราฟ (Bottom), ด้านมุมกราฟ 
(Corner), ด้านบนกราฟ (Top) ด้านขวากราฟ (Right) และ ด้านซ้ายกราฟ (Left) 

เมนูย่อย Data Labels เกี่ยวกับการก าหนดให้แสดงข้อมูลบนกราฟหรือไม่  ประกอบด้วย 

 Series Name  ก าหนดแสดงช่ือกลุ่มชุดข้อมลูบนกราฟ 

 

Legend 
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 Category name  ก าหนดให้แสดงข้อความในแกน X บนกราฟ 

 value  ก าหนดให้แสดงค่าในแกน Y บนกราฟ 
เมนูย่อย Data Table  เกี่ยวกับการแสดงตารางข้อมลูต่อท้ายกราฟ  ประกอบด้วย 

 Show data table  ก าหนดให้แสดงตารางข้อมูลต่อท้ายกราฟ 

 Show legend keys  ก าหนดใหแ้สดงสีของ legend ที่ช่ือในตารางข้อมูล 
   - คลิกปุ่ม Next > เพื่อเข้าสู่ขั้นตอนที่ 4  Chart Location   ดงัรูป 

 
 
 
 
 
 
 

 

รูปที่ 41 การสร้างกราฟในขั้นตอนที่ 4 
 

ในขั้นตอนท่ี 4 เป็นการระบุเพื่อใหก้ราฟท่ีถูกสร้างขึ้นน าไปวางไว้ในบริเวณทีต่้องการมีตัวเลือกเพื่อให้
คลิกเลือกในส่วน Place Chart ดังนี้  

 As new sheet:  กราฟท่ีสร้างไดจ้ะน าไปว่างใน work Sheet แผ่นใหม่ ตามที่ก าหนด 

 As Object in:  กราฟท่ีสร้างได้สามารถก าหนดใหเ้ป็นวัตถุ(เหมือนรปูภาพ) เลือกให้น าไปวางใน 
Work Sheet ที่ต้องการได ้

- ผู้ใช้สามารถ คลิกปุ่ม <Back เพื่อย้อนกลับไปแกไ้ขในข้ันตอนท่ีผ่านมาแล้วได้ 

- คลิกปุ่ม Finish เพื่อให้ Excel สรา้งกราฟท่ีต้องการ  กราฟท่ีสร้างได้ดังรูป 

 
 

รูปที่ 42 เมื่อเสร็จสิ้นการสร้างกราฟจะได้กราฟเส้นตามต้องการ 
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c. การแก้ไขกราฟ เมื่อสร้างเสร็จแล้ว 
เมื่อสรา้งกราฟได้แล้ว หากต้องการแก้ไข ปรับแต่งกราฟ ย่อ/ขยาย ขนาดของกราฟได้

เหมือนกับการย่อ/ ขยายขนาดของรูปภาพหรือ วัตถุ (object) ได้ ดงันี้ 
1. คลิกท่ีพื้นท่ีของกราฟท่ีต้องการแก้ไข จะเห็นว่ามีกรอบและสีเ่หลีย่มเล็กๆ ล้อมรอบกราฟ 
2. คลิกปุ่มขวาของเมาส์ ท่ีพื้นที่ของกราฟ เพื่อเลือกแก้ไข ดังรูป จะมีตัวเลือกดังนี้ 

o Format Chart แต่งสีพื้น ใส่กรอบ ใส่รูปภาพพ้ืนหลังให้กราฟได้ 
o Chart type (ขั้นตอนท่ี 1)  ปรับเปลี่ยนประเภทของกราฟ 
o Source Data (ขั้นตอนท่ี 2)  ปรบัเปลี่ยนแหล่งข้อมูล 
o Chart Option (ขั้นตอนท่ี 3)  ปรบัเปลี่ยนรายละเอียดค าอธิบายกราฟต่างๆ  
o Location (ขั้นตอนท่ี 4)  ปรับเปลี่ยนบรเิวณที่วางกราฟ 
 
 
 
 
 
 
 
 
 
 
 
 

 

รูปที ่43 แสดงการคลิกขวาท่ีกราฟเลือกแก้ไขในขั้นตอนที่ต้องการ 

 
16. การจัดเรียงข้อมูล (Sorting) 

a. การจัดเรียงข้อมูลจากน้อยไปมาก (Ascending) 
1. ท าแถบสีกับกลุ่มข้อมลูที่ต้องการจัดเรียงข้อมูล 
2. คลิกเมนู Data -> Sort   จะปรากฏ Sort Dialog ขึ้น ดังรูป 
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รูปที่ 44  การเลือกค าสั่งให้เรียงข้อมูลจากน้อยไปหามาก (Ascending) 

 
3. ในส่วน Sort by ให้เลือกกลุ่มของข้อมูล ท่ีต้องการจัดเรียง และก าหนดเลือก Ascending คือ
เรียงจากน้อยไปหามาก 
4.  คลิกปุม่ OK เพื่อให้ Excel ด าเนินการจัดเรียงข้อมลู 
 

b. การจัดเรียงข้อมูลจากมากไปหาน้อย (Descending) 
1. ท าแถบสีกับกลุ่มข้อมลูที่ต้องการจัดเรียงข้อมูล 
2. คลิกเมนู Data -> Sort   จะปรากฏ Sort Dialog ขึ้น ดังรูป 
 
 
 
 
 
 
 
 
 
 
 

 

รูปที่ 45 การเลือกค าสั่งให้เรียงข้อมูลจากมากไปหาน้อย (Descending) 
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3. ในส่วน Sort by ให้เลือกกลุ่มของข้อมูล ท่ีต้องการจัดเรียง และก าหนดเลือก Descending 
คือเรียงจากมากไปหาน้อย 
4.  คลิกปุม่ OK เพื่อให้ Excel ด าเนินการจัดเรียงข้อมลู 

 
17. การค านวณ ต่าง Work Sheet 

ในการค านวณต่าง Work Sheet จะมีลักษณะที่ต่างจากการค านวณภายใน Work Sheet อยู่ส่วนหนึ่ง 
เท่านั้น น่ันคือ เมื่อต้องการอ้างข้อมูลที่อยู่ใน Work Sheet ไหน ก็จะต้องมีการอ้างถึงช่ือ Work Sheet ที่จะน า
ข้อมูลมาค านวณ โดยจะมีรูปแบบในการอ้าง Work Sheet  ดังนี ้

 ชื่อ Work Sheet ที่อ้างถึง ! Range ของข้อมลูใน Sheet ที่อ้างถึงเพ่ือน ามาค านวณ 
** สังเกตว่า หลังจากช่ือ Work Sheet แล้วจะต้องมีเครื่องหมาย  ! อยู่หลังช่ือ Work Sheet เสมอ
แล้วหลังเครื่องหมาย ! ก็จะเป็นการอ้างถึงข้อมูลภายใน Work Sheet นั้นตามปกต ิ 

 

ตัวอย่าง ต้องการค านวณโดยหาผลรวมของข้อมูลช่วง A1 ถึง B10 ใน Work Sheet ช่ือ Sheet1  
โดยให้แสดงผลลัพธ์ ใน Work Sheet ช่ือ Sheet3 ที่เซลล์ A1  จะสามารถป้อนสูตรในเซลล์ A1 ใน 
Sheet3 ได้ดังนี ้
 1. คลิกเมาส์ที่ช่ือ Sheet3 ให้ Active  
 2. คลิกท่ีเซลล์ A1 ของ Sheet3 เพื่อป้อนสูตร โดยพิมพ์สตูร    = SUM(Sheet1!A1:B10) 
 3. กดปุ่ม enter เพื่อจบการป้อนสูตร ก็จะได้ผลลัพธ์แสดงท่ีช่อง A1 ของ Sheet3  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

รูปที่ 46 ข้อมูลดิบที่อยู่ใน Work Sheet ชื่อ Sheet1 
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รูปที่ 47 ผลที่ได้จากการค านวณข้าม Work Sheet แสดงผลลัพธ์ใน Sheet3 

 
18. ตัวอย่างการใช้งาน ฟังก์ชัน IF  ในการค านวณเกรด 

วิชา SCCS100 มีนักศึกษาอยู่ 5 คน โดยมีคะแนนดิบที่เขาสะสมได้ดงัตารางข้อมูลเซลล์ A1 ถึง A5 
และให้แสดงผลลัพธ์ของการตดัเกรดที่เซลล์ C1  ถึง C5    

 
 

รูปที่ 48 ลักษณะตารางข้อมูลดิบ และ Sheet 3 ที่ Active อยู่ 
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อาจารย์ต้องการตัดเกรดนักศึกษาท้ัง 5 คนนี้ โดยมีเง่ือนไขในการตัดเกรด ดังนี้ 
คะแนน มากกว่าหรือเท่ากับ 85 คะแนน    เกรด A 
คะแนน มากกว่าหรือเท่ากับ 70 และไม่เกิน  85 คะแนน  เกรด B 
คะแนน มากกว่าหรือเท่ากับ 60 และไม่เกิน 70 คะแนน  เกรด C 
คะแนน มากกว่าหรือเท่ากับ 50 และไม่เกิน 60 คะแนน  เกรด D 
คะแนน น้อยกว่า 50 คะแนน     เกรด F 

 

 - พิจารณาเง่ือนไขและวิธีการตัดเกรดให้เข้าใจถึงการท างาน นั่นก็คือ เมื่อน าคะแนนของนักศึกษา 1 
คนเข้ามาพิจารณา นักศึกษาคนนี้จะต้องได้เกรดใดเกรดหนึ่ง ( A ถึง F) ไป การพิจารณาเง่ือนไขจะมีลักษณะที่
สัมพันธ์กัน 

-  ต้องการให้เกรด แสดงที่เซลล์ C1 ถึง C5  ด าเนินการพิมพ์สูตรในเซลล์ C1 เพื่อเป็นเซลล์ต้นฉบับ 
โดยที่เซลล์ C1 สูตรจะน าข้อมูลมาจากเซลล์ A1 น ามาพิจารณาในเง่ือนไข  ส่วนเซลล์ C2 ถึง C5 ท าส าเนาจาก
เซลล์ C1 โดยอ้างอิงต าแหน่งแบบสัมพัทธ์ 

มีขั้นตอนปฏิบัตเิพื่อค านวณเกรด ดังนี้ 
1. คลิกเมนู Insert -> Function -> เลือก Or Select a category เป็น All 
2. เลื่อน Scroll bar เพื่อเลือกฟังก์ชัน IF  หากพบแล้วให้คลิกที่ช่ือฟังก์ชัน IF 
3. คลิกปุ่ม OK  เพื่อเข้าสู่การป้อนอาร์กิวเมนต์ให้ฟังก์ชัน IF 
4. เมื่อเห็น Function Argument Dialog ให้ป้อนข้อมูลลงไปท่ีละสว่นดังนี้ 

 
 
 
 
 
  

 
 
 
 
 

 
รูปที่ 49 ลักษณะส่วนที่รอการป้อนอาร์กิวเมนต์ให้กับฟังก์ชัน IF 
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Microsoft Excel 

ในส่วน Logical_test ท าการป้อนเงื่อนไขทางตรรกะตัวแรกในการตัดเกรด โดย
จะใช้เงื่อนไขของการ ตัดเกรด A    จะได้เง่ือนไข คือ   A1>=85 

 ในส่วน Value_if_true  ท าการปอ้นสิ่งที่ต้องการท า หรือค่าท่ีต้องการแสดงเมื่อเงื่อนไขที่
ตรวจสอบเป็นจริง  ดังนั้นในส่วนนี้จะป้อนตัวอักษร A ลงไป โดยจะต้องมีเครื่องหมาย Double Quote คร่อม 
ตัวอักษรใส่ลงไป  คือ  “A” 

 ในส่วน Value_if_false ท าการป้อนสิ่งท่ีต้องการท า หรือค่าท่ีต้องการแสดงเมื่อเงื่อนไขที่
ตรวจสอบเป็นเท็จ  ดังนั้นในส่วนนี้จะยังป้อนตัวอักษรไปเลยไมไ่ด้ เพราะนักศึกษาอาจจะไดเ้กรดที่อยู่ในช่วง B 
ถึง F ได้ ในส่วนนี้ก็จะต้องป้อน เงือนไขในการตัดเกรดของเกรด B ลงไป แล้วก็พิจาณาอย่างน้ีไปจนครบเกรด F 
ดังนั้นในส่วนน้ีก็จะได้สตูรที่จะป้อนเข้าไป คือ  IF(A1>=70, “B”, IF(A1>=60, “C”, IF(A1>=50, “D”, 
“F”))))   

5. เมื่อป้อนข้อมูลให้กับฟังก์ชัน IF เสร็จแล้ว-> คลิกปุ่ม OK เพื่อจบการท างาน 
6. สิ่งที่ได้ จะได้เกรดของนักศึกษาคนแรกท่ีมีคะแนนอยู่ในเซลล์ A1 ออกมา คือเกรด D  ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 50 เมื่อป้อนอาร์กิวเมนต์ให้ฟังก์ชัน IF ในเซลล์ C1 

 
** เมื่อดูจากแถบสูตรของเซลล์ C1 เมื่อท าส าเรจ็แล้ว  
   เซลล์ C1 มีสูตรคือ  =IF(A1>=85,"A",IF(A1>=70, "B", IF(A1>=60, "C", IF(A1>=50, "D", "F")))) 
7. ท าการ copy สูตรจากเซลล์ C1 ไปยังเซลล์ C2 ถึง C5  โดยการคลิกมุมล่างด้านขวาของเซลล์ C1 
8. ท าการ Drag จากเซลล์ C1 ผ่านเซลล์ C2 ไปสิ้นสดุที่เซลล์ C5 
9. ปล่อยคลิก สิ่งที่ได้จะเป็นเกรดของนักศึกษาท้ัง 5 คนปรากฏให้เห็น  ดังรูป  
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รูปที่ 51  เมื่อด าเนินการ copy สูตรจากเซลล์ C1 ไปยังเซลล์ C2 ถึง C5 

 
 
 
 

 

 


